Having two products creates one of the more sensitive issues we have to deal with, namely: where should we land on the spectrum of making customers aware of the newer product line? On one side you seem to become an obnoxious purveyor of a potentially unwanted product. But on the other side you end up with customers dissatisfied because they are unaware of the innovation you are offering.

It's a tough call especially because each customer has a different reality based on their unique experience with our communications. But we feel a responsibility to keep you informed, even at the risk of appearing aggressive. Because like Windows did to DOS (remember DOS?), when our ViewPoint Windows-based product was replacing OneTouch, the cloud is quickly becoming the standard over programs restricted to localized Windows environments. And we want our customers to be aware that we offer the premium cloud solution!

That said, to our legacy ViewPoint customers – please know that we are happy with your system if you are. We don’t mean to push you to Edge Cloud unless or until the time is right. But if someday you begin to feel that ViewPoint seems dated, either in terms of appearance or functionality, please know that we have the next generation solution ready and waiting for you.

For our Edge Cloud customers – thank you for the trust and loyalty you have placed in us. You are well versed in the benefits that the cloud brings, including freedom from servers, backups, worrying about your data, combined with new functions like live dashboard metrics, smartphone apps for you and your patients, auto-patient pop-ups via caller ID, and much more.

Elsewhere in this issue, we share the story of a ViewPoint customer that decided to make the move to Edge Cloud, then changed his mind and returned to ViewPoint. What!? Read Dr. Stuart Robb’s experience for an interesting perspective on both ViewPoint and Edge Cloud. (Spoiler alert - he ends up back with Edge Cloud, but shares an interesting perspective about when and why he chose to do so.)

Knowledge is power. The decision to make a transition to Edge Cloud should be based on when it is right for you, but is an ongoing conversation you should be having with your Ortho2 Regional Manager.
Come join us for the 34th annual Users Group Meeting in Savannah, Georgia! The meeting will take place February 22-24, 2018 at the Savannah Marriott Riverfront Hotel. You should be receiving your meeting brochure in the mail soon, which is filled with information about the classes offered and meeting location.

Register online at www.ortho2.com/ugmregistration. Be sure to register quickly as some classes fill up fast. If you have questions, contact Kim Barker, Meeting and Event Coordinator at (800) 678-4644 or ugm@ortho2.com.

We hope you will come to the Users Group Meeting to experience the:

**Classes**

Join our keynote speaker Darryl Davis and more than 30 Ortho2 staff, industry-leading consultants, and doctors for classes about Edge Cloud, ViewPoint, and how to make your practice run more efficiently.

**Fun**

Get your walking shoes ready to enjoy the spirits of Savannah while sipping your favorite spirit. Join us for a Creepy Pub Crawl for a ghostly adventure you will never forget! Reserve your tickets when you register.

And don’t forget about our Pirates in Paradise party Thursday evening. Come dressed as your favorite pirate and capture keys from the Ortho2 brigade for a chance to win some great pirate’s booty. While dressing up isn’t required to enjoy the festivities, it is encouraged. Awards will be given for the best costumes.

**Contributor Contact Information:**

K. Ryan Alexander – Ryan Alexander is a senior consultant with Alexander & Sons. He provides comprehensive orthodontic consulting services, with an emphasis in Doctor Time Scheduling. Contact Ryan at ryan@alexanderandsons.com or call (760) 539-6736.

Mary Kay Miller – Mary Kay Miller is an Internet Marketing Consultant. For more information visit www.orthopreneur.com, or schedule a complimentary Internet marketing evaluation at (877) 295-5611 or email mk@orthopreneur.com.

Dr. Roger P. Levin – Dr. Roger P. Levin and Levin Group provide expert orthodontic practice management and marketing solutions. For more information, contact Levin Group at (888) 973-0000, or visit them at levingroup.com/ortho.
BE SOCIAL THIS UGM!

Be sure to follow Ortho2 on Facebook for additional and fun information leading up to the UGM. We’ll have live videos featuring frequently asked questions, party info, and how to get active with Ortho2 on social media while you’re in Savannah.

We are excited to announce Ortho2 will have a Snapchat account for this year’s UGM! You’ll now get to use your favorite filters while taking pictures and videos with your UGM friends. There will even be some new UGM filters to try out!

Savannah is the perfect place to fill up your Instagram page with picturesque scenes! We want to see all the fun you’re having while attending the UGM. Be sure to use #O2UGM18 while posting, and don’t forget to follow Ortho2Systems on Instagram.

#O2UGM18

We want to showcase your pictures! Be sure to use the hashtag #O2UGM18 when posting your UGM and Savannah photos for a chance to be featured on our social media TV!

If you are planning a presentation or lecture at a society meeting, university, or local meeting, we can provide you with any screenshots you need and can discuss how to best use Edge Cloud and/or ViewPoint in any situations you may be illustrating. We appreciate the good word you spread and would like to assist in any way we can!

Come visit us at these fall meetings.

Southern Association of Orthodontists
Pacific Coast Society of Orthodontists
CBCT in Orthodontics
The MKS Forum
Middle Atlantic Society of Orthodontists
Northeastern Society of Orthodontists

October 6–7, 2017
October 13–14, 2017
October 27–28, 2017
October 27–28, 2017
November 3–5, 2017
November 10–11, 2017
Dr. Stuart Robb takes pride in keeping his office running on schedule 100 percent of the time. His schedule is worked out so perfectly that he even advertises to prospective patients that each appointment will start on time. For years, Dr. Robb relied on ViewPoint to manage his schedule. Earlier this year, Robb Orthodontics made the transition to Edge Cloud, the second time his team has done so.

Dr. Robb first became familiar with Ortho2 ViewPoint while working at the University of Chicago. When he took over his current practice – offices in both Lake Forest and Highland Park, Illinois – he had been using two different practice management systems, but chose to continue with ViewPoint.

Dr. Robb explains that the office locations are only ten minutes from each other, so patients can be seen at both offices. With his ViewPoint setup, he ran a VPN connection to ensure he could access the same information at each location. Because of his interest in IT, Dr. Robb didn’t hire an outside tech, and instead did the work himself with both offices. While connecting between the offices through a VPN worked, he called it a headache every time something went wrong.

“There was always ten percent of me every night that worried about my data. I have no paper in my office. Everything is electronic. If I have an issue with my data, I would be in big trouble,” he says.

This point hit hard when a tenant above his practice partially flooded his office. Luckily, the water didn’t reach the server. But Dr. Robb’s biggest fear of losing his data, not being able to locate a viable backup, and ultimately his office being down while he fixed the problem made him look at the then brand new Ortho2 Edge Cloud.

Robb Orthodontics was one of the first practices to move to Edge Cloud in 2010. What interested Dr. Robb the most was that he would no longer have to worry about backups, lost data, or not being able to access ViewPoint if the Internet was down. It was the peace of mind he was looking for.

However, after making the conversion, Edge Cloud wasn’t performing as it should, at least partly due to the Internet service within the office. Edge Cloud was performing at a non-optimal speed.

When seeing patients Dr. Robb moves around in the software – pulling up images, closing them, viewing treatment charts, and any notes he left himself. The need to navigate the software quickly was paramount to keep his practice running on time.

This led Dr. Robb to switch back to ViewPoint. “In general, I never had a problem with ViewPoint. It’s the stable platform I used for everything,” he says.

A few years after his return to ViewPoint, Jesse Howard, Ortho2 Senior Regional Manager, reached out to Dr. Robb to start the conversation about the changes Edge Cloud had seen, including lower bandwidth requirements and services that weren’t offered during his initial transition.

Dr. Robb makes it a point not to partner with a lot of vendors. He doesn’t like to shop around, or jump from one program to the next. So hearing that Edge Cloud could offer him what he needed for his practice was a plus. What convinced him to make the switch, for the second time, was not having to worry about his data, a server, or a VPN, thus removing himself from the IT role.

A colleague had just been affected by a ransomware virus and was living the nightmare Dr. Robb had always been concerned about. “With Edge Cloud, I know my data is in a datacenter that has the highest security, and I don’t have
to worry about any practice management backups.”

In addition, concerns about accessing data in the rare instance the Internet goes down is gone. With Edge Mobile, Dr. Robb can still access the schedule, patient information, and images all from his tablet and cell phone. And that instant access also translates to information when Dr. Robb is out of the office and at home.

The IT side of things isn’t the only reason Dr. Robb has seen a benefit in his office. The feature-rich and customizable program can truly be all-encompassing. And with the lower bandwidth requirements, Dr. Robb can easily go through several images and X-rays quickly during an appointment.

Dr. Robb also saw value in staying with Ortho2. “Some other companies get bought out and you are forced to integrate with another partner. I like that Ortho2 is based in Iowa and is privately owned. Their employees are stable and have been there a long time,” he says.

The training Robb Orthodontics went through helped them learn the ins and outs of day-to-day operations within Edge Cloud. He explains the conversion was much easier than he thought it would be.

“I think the anxiety of switching practice management software is a big deal for orthodontists. Everyone has heard nightmares about a transition,” Dr. Robb says. “The transition from ViewPoint to Edge Cloud was easy, and we didn’t have any hiccups. When I think back and try to find a problem I had, there wasn’t one.”

And now, Dr. Robb doesn’t hesitate to recommend Edge Cloud to anyone, but in particular ViewPoint users. After all, his practice is still running on time. Every day.

Storing your data in the cloud and access to mobile offerings aren’t the only reasons to look at Edge Cloud. Edge Cloud offers many advantages over ViewPoint including:

- Even more apps! Edge Portal allows your patients and responsible parties to view their account information and see their next appointment online. Edge Cloud even offers an app branded for your office. Practice Connect lets you get information to your patients in an easy to use way. Use the app to market to prospective patients, too.

- Another easy way to keep in contact with your patients is through Edge Broadcast, a newsletter system that comes with Edge Cloud. These newsletters are a great way to keep your patients informed not only about things happening at your practice, but also new treatment options, proper hygiene reminders, braces-friendly recipes, etc.

- The usability of Edge Cloud is truly set up for you. The Dashboard allows each user the ability to see exactly what they want to see when opening the program. Edge Cloud has true multiple screen usability so you can see multiple parts of the program at once.

- The treatment hub is your one-stop for all patient information. Use the notepad to take any additional notes you want to have. You can even subgroup or set up a workflow from information within the treatment chart.

- The Smart Scheduler optimizes your search for new appointments. See what times and days your patients are typically seen, and easily schedule procedure groups and chains. Additional, you can see other family appointments.

- And new features are added frequently. With new features like Edge Pop, Edge Signature, and Edge Specialist, Edge Cloud continues to evolve year after year.

For more information about Edge Cloud, contact your Regional Manager at (800) 678-4644 or sales@ortho2.com.
Introducing the Coordinator System

Management is fun!” exclaimed no doctor ever as her two best assistants, on the same day, hand her their two weeks’ notice. True story. This recently happened. The problem most doctors face is they have very little systems in place in the way of management – which is fine for a practice that has two employees. But as the business grows, the management structure should grow with it, but rarely does. The doctor ends up managing all fifteen team members, and calls me up at fifty-years-old to see how much he can sell his practice for on the open market.

Rather than selling your practice young, I suggest starting the process of developing a solid coordinator system.

The coordinator system consists of three superstar employees that manage the three main areas of the orthodontic practice: the front office, the back office, and the sales/marketing office. The respective positions would be the office coordinator, the clinical coordinator, and the treatment coordinator. In many offices, everyone is a coordinator of something: the scheduling coordinator, financial coordinator, epic technician RDA superstar patient flow coordinator, etc. But the reality is you need three lead team members in the three key areas of the practice, and those leads manage their respective areas which ultimately reduces the management burden on the doctor.

The main purpose for developing management structure is to improve communication in the office. The office coordinator should be monitoring the key numbers of the practice, including the income, production, past due accounts, etc. They should have a global view of how the business is doing. The clinical coordinator should be monitoring treatment quality and control. What is your average treatment length, and is this over or under your estimates? Are the assistants staying on time with their chairs? (I’ll be lecturing at the Users Group Meeting in February 2018 on developing a strong scheduling system, and in this lecture I will be reviewing the role of the clinical coordinator.) Finally, the treatment coordinator should be monitoring every single new patient exam, and should have a strong system for tracking new and observation patients.

Coordinators lead by example, and we like to associate their management style to that of a point guard on a basketball team. The point guard calls out the plays and directs the team. Rarely does the point guard score the most points, but oftentimes tallies the most assists, which don’t always show up on the ESPN highlights. No matter how much the point guard wants to shoot the ball, their primary role is to help all their teammates feel a part of the game and to sense the satisfaction of achievement.

Once a month the doctor should meet with the coordinators. This is a great time to update the doctor and

Coordinator System continued on page 15

About the Author

Ryan Alexander is a senior consultant with Alexander & Sons. He is well versed in every aspect of practice management and has exceptional expertise in Doctor-Time Scheduling, New Patient Enrollment, Marketing, Customer Service and Team Building.
The grace period is over. If you haven’t updated your website to a responsive design that is optimized for devices of all sizes, your online ranking is in jeopardy.

The writing has been on the wall for about two years that mobile phones were taking over local search. Around May 2015, it was announced that more than half of all Google searches were performed on mobile devices. By August 2016, that number approached 60 percent.

In response to the undeniable proliferation of mobile search, Google is adding a key component to their search algorithms: mobile-first indexing.

What is Mobile-First Indexing?
The name is fairly straight-forward! Instead of analyzing and judging a website based on its full-screen, desktop/laptop appearance, Google will now make its primary evaluation of a site based on how it appears and performs on a mobile device.

Because the majority of online searches are now conducted using phones, Google is adjusting their algorithm to place primary importance on mobile devices. Computer and laptops are taking a back seat from a ranking relevancy standpoint.

Many orthodontic practices have updated their websites in the last year or two. Those who already updated should have nothing to worry about, as long as the on-site SEO has been applied correctly. However, this algorithm change could levee harsh ranking penalties against practices that have not updated their website for several years, as well as practices that have outdated secondary mobile solutions or no mobile solution at all.

How Do I Prepare for Mobile-First Indexing?
The biggest factors on mobile search heading into 2018 are load time and access to information. Your site needs to load quickly, offer useful information, and be easy to use on a phone.

If a site is slow to load, it will receive low marks for visitor engagement and mobile performance. Remember that many mobile searches are conducted while the user is connected to a cellular network or shoddy WiFi; modern sites need to load fast and work seamlessly.

Another vital component of mobile-first indexing is simple, intuitive site navigation. You can’t force consumers to squint, scroll, and scan for important information, because they just won’t do it. People today are impatient and expect instant gratification. Make it fast, make it easy.

One of the biggest culprits of slow load time is large images. When images are optimized for the Internet, they need to be compressed and/or resized with mobile users in mind. Images that look great on a computer might not look so great on a phone. Business owners need to plan and test their websites with mobile users in mind.

What Will Happen if My Website Isn’t Updated?
Outdated websites could drop significantly in the search results. Among the roughly 200 ranking signals used by Google to evaluate a website, some of the most important are authority, relevance, and site design.

If a website is not optimized for mobile, then it loses relevance. As its relevancy score drops, so does its authority as a valuable website to be included in the search results. Failure to update your website could result in a

Mobile-First Indexing continued on page 15

About the Author
Mary Kay Miller is an Internet Marketing Consultant for the orthodontic profession specializing in, WordPress Website Design, SEO, Reputation Marketing, Local Search Strategies, and Exclusive Web 2.0 services.
Eight Management Mistakes Orthodontists Make

If I could just focus on the orthodontics, everything would be great.” I’ve heard that statement or something like it from countless orthodontists over the years. It’s totally understandable. You went to dental school and completed your orthodontic residency to learn how to be a clinician, not a practice owner.

But here you are in 2017, an owner of an orthodontic practice. For all intents and purposes, your office does pretty well. You have a strong team, your patients like you, and, even though you’re not Warren Buffett, you’ve managed to pick up enough business knowledge along the way to do a decent job of running a financially successful practice.

But boy, there are some days when you wish you didn’t have to deal with all these management-related issues. One way to get better at almost anything is by learning what NOT to do.

Here are eight practice management mistakes that every orthodontist should avoid:

1. **Outdated Systems**

As systems age, they become more inefficient, which increases stress and decreases production. Systems should be replaced every 3–5 years. Your practice is in a constant state of change. Some changes may be small, others big, and over time, as more changes occur—technology, services, personnel, etc.—your systems become obsolete. At the time they were created, they were an operational snapshot of the office as it was, but that practice has continued to morph in the intervening years, so those original systems are no longer an accurate reflection of how the office currently operates. This dissonance produces incredible stress on the team. The older the systems, the greater the stress!

2. **Poor Communication**

Many orthodontists don’t share essential information with their teams. Does your staff know the practice vision? What about the practice’s goals for annual production, referrals, starts, and overhead? Do you review progress on performance targets once a week at the morning meeting?

Too often doctors believe team members don’t need to know such information. By keeping your team in the dark, you’re sending them blindly into the future—where they can’t help but stumble repeatedly!

3. **Clinging to the Status Quo**

I get it. Change isn’t easy. But holding onto the inefficient, the dysfunctional, and the under-performing just because you’re familiar with them, doesn’t make a whole lot of sense especially over the course of your career. That reception area painted hunter green may have looked great in 1993, but not so much anymore. That templated geocities website may have been state-of-the-art sometime in the last century, but now it’s just a crumbling fossil of a time gone by. These may be extreme examples, but we all have a tendency to hold on to things because we’re comfortable with them. As one of my former mentors once said to me, “If you want to grow, you’ve got to let go.” I’m not saying you have to jump on every trend, but you don’t want to live in a time capsule either.

4. **Stop-and-Go Marketing**

You put some killer strategies in place for parent and doctor referrals and they start paying off like gangbusters. Your consult schedule is booked for the next two months. Your starts are skyrocketing. With everything going so well, you believe you can put the brakes on marketing. But once you do, things eventually slow down. Then you start to panic and say, “We need to ramp up our marketing and quick!”

The better strategy is to keep your foot on the
accelerator. You will retire some strategies and rotate others, but marketing should be consistent and ongoing. If your marketing is working, why stop it? Let it continue to fill your schedule with new patients!

5. **Not Asking for the Close**

You can give the greatest ortho presentation in the world, but if you fail to ask for the close, you will lose a lot of cases. Don’t assume parents will volunteer a yes. You have to ask them point-blank if they would like their child to receive the benefits of orthodontic treatment at your office. It seems simple enough, but some orthodontists (and TCs) don’t want to seem pushy or like they’re pressuring parents.

But if parents expressed enough interest to schedule and show up for the consult, it’s only fitting that you gauge their intentions by asking them to choose your practice for their child’s orthodontic care. If you’ve done a good job of making the case, they will most likely say yes. If they say they need more time, make sure to follow up with them in a week. See the next point.

6. **Failure to Follow Up With Uncommitted Parents**

Ortho consults aren’t the slam dunk they once were. More parents are willing to shop around for ortho care today than in the past. Saying yes to treatment that typically costs $5,000 or more is taking longer for more and more parents. Many ortho practices fail to follow up with parents who say they need more time or need to think about it. There could be many reasons parents refrain from saying yes right away. You might be the first practice they are visiting. Parents may want to talk it over with their spouse (who didn’t attend the consult). They may have other financial commitments they have to work through before making a decision.

As long as they don’t say no, follow up with them within a week. See where they are in the decision-making process. Offer to hold a second consult with their spouse, if necessary. It could be a toss-up between your practice and another one. Your follow-up phone call could be the difference-maker in such a scenario.

7. **Tolerating Poor Performance**

Most people don’t like confrontation. Yet, as the practice owner, you can’t let an employee who consistently underperforms get away with doing less than her co-workers. It’s not fair to them or to you.

Everybody will occasionally make a mistake, but there are some employees who, for whatever reason, aren’t fully contributing to the practice’s success. If they’re not held accountable, they will continue to underperform, causing dissension and resentment among the rest of the team.

You need to talk to employees in private. Review their recent performance issues. Be as specific as possible. Provide goals for them to improve, and give a time line. If they meet the objectives, great. If not, you will need to invoke further disciplinary measures. Once you have finished this initial meeting, document the conversation in the employee’s personnel record.

Many people will up their game after such a conversation. Plus, the rest of your team will appreciate that you tackled this issue. If the employee fails to perform as expected, then follow through by

**Management Mistakes continued on page 15**

---

**About the Author**

Dr. Roger P. Levin is Chairman and Chief Executive Officer of Levin Group, Inc. Need help reaching your goals faster? Visit www.levingroup.com/consulting to see how our solutions can help accelerate your practice success.
Free Webinars

We offer you free, online, real-time webinars each month throughout the year on various topics. It’s a great solution for training new users, refreshing experienced users, or learning about new features. Webinars are offered several times each month so you can choose the time that fits best with your schedule. Preregistration, a computer with a high-speed Internet connection, and a phone are required. Questions? Contact Judy Brown at (800) 346-4504 or jkb@ortho2.com.

Upcoming Webinar Dates

**Edge Cloud: Patient Contracts**

Thursday, October 12, 10:00-11:00 A.M. Central Time  
Wednesday, October 25, 2:00-3:00 P.M. Central Time

Contracts track the financial obligation of all associated responsible parties and insurance companies individually. We’ll demonstrate entering new contracts, deleting contracts, and editing details, members, and fee allocations to existing contracts. Finally, we will walk through merging partial contracts and creating open-ended contracts.

**ViewPoint: Posting Financial Transactions**

Wednesday, November 8, 10:00-11:00 A.M. Central Time  
Tuesday, November 21, 2:00-3:00 P.M. Central Time

Everyone likes to get paid. Make sure your money is going where it should by learning how to master posting charges, payments, and other adjustments with your ViewPoint financial tools. You will leave this webinar a financial master.

**Edge Cloud: Merge Queue Tools**

Tuesday, December 5, 2:00-3:00 P.M. Central Time  
Wednesday, December 20, 10:00-11:00 A.M. Central Time

Use the merge queue to store mail merge documents waiting to be sent to patients, parents, and professionals. After you have added documents to your queue, open the merge queue to review the list, add notes, approve final documents, and complete the merging process.

On a Personal Note

Rachel Johnson, Ortho2 Network Engineer, and Sean Gildersleeve, Ortho2 Software Support Representative and Trainer were married on June 24. They share a passion for Iowa State, and even had Cy, the Iowa State University mascot make a special appearance at the wedding. Congratulations you two!
Ortho2 Anniversaries

Congratulations to these Ortho2 staff members who celebrated anniversaries during the third quarter of 2017.

Thirty Years
Sara Harbacheck  

Twenty-Three Years
Judy Brown  

Twenty-Two Years
Marla Miller  

Twelve Years
Michelle Kinnaman  

Nine Years
Cal Rebhuhn

Eight Years
Judy Denny
Paul Ezerski  

Six Years
Brent Jacobsen
Steve Mahan  

Five Years
Rachel Johnson
Andrew Smith

Four Years
Wesley DeShaw

Three Years
Bryan Reiter
Jorge Rios
Nathan Hemmings

Two Years
Nick Johnson

Career Milestones and Development

Nathan Hemmings joined the ranks of Advanced Support on July 31. He has been with Ortho2 since 2014 as a Software Support Representative and Trainer. Congratulations, Nathan!

Sara Harbacheck celebrated her 30th Ortho2 anniversary on August 13. The celebration included cake and stories from the past. Congratulations on this accomplishment, Sara!

Tanner Majors was welcomed to the Ortho2 team on August 21 as a Software Support Representative. We are glad to have Tanner join us!

[Image of Sara Harbacheck with a cake, celebrating her 30th Ortho2 anniversary]
Chat Support

Do you need to call into our Support Team for a question, but it’s difficult to wait on hold, even for a few minutes? Ortho2 has you covered! Use our chat support to get in contact with us. When you use the chat support feature, you will be added to the same queue as phone calls. You can choose to chat with the Software Support, New Customer Care, or Network Engineering Teams.

In Edge Cloud, you can find links to chat support through the Help menu. In ViewPoint version 11, it is the bottom right Help button in the Daily Activities menu.

So drop us a line when you are in a pinch! We are here to help you in whatever way is most convenient for you.

Help Us Help You

Please be prepared to provide your customer number, practice name, and office location when you call our support teams for assistance. You can find your customer number in Edge Cloud by clicking File > About. If you use ViewPoint, you will find your customer number by clicking the Help menu and choosing About. Please be sure to provide this information—and repeat your phone number—when leaving a phone message requesting support. Having clear information helps us serve you more quickly.

Support

By Phone: (800) 346-4504
Available 7:00 A.M. – 7:00 P.M. Central Time, Monday–Friday

By Fax: (515) 233-1454
You can fax us support requests. While not required, forms that help identify these requests are available at www.ortho2.com > Support & Learning > Requests/Forms > Fax Support.

By E-mail: ortho2support@ortho2.com
Response time is usually the same day or at most within 24 hours.

And Don’t Forget Our Website: www.ortho2.com
Our website gives you 24/7 access to our knowledge base, FAQs, white papers, visual help videos, and more.
Holidays

Our corporate office is closed on the following holidays:

- New Year’s Day
- Memorial Day
- Independence Day
- Labor Day
- Thanksgiving Day
- Christmas Day

If a holiday falls on a Saturday, we observe the holiday on the prior Friday. If a holiday falls on a Sunday, we observe the holiday on the following Monday.

The Friday after Thanksgiving, Christmas Eve, and New Year’s Eve are optional holidays. We offer limited support on those days.

Log into the Customer Site of Ortho2.com

There are many resources available to you on our website. You will find visual help files, printed documentation, FAQs, information on upcoming meetings, the ability to register for webinars, and more.

If you haven’t already created an account to access the Customer Site of our website, you will need to do that. Each doctor and staff member can create their own account. Visit www.ortho2.com, and click the feature you want to see, such as Edge Cloud videos or ViewPoint documentation.

Next, click the Register a New User Account link on the login screen. You will be prompted for your full name, main office phone number, and Ortho2 customer number. Finally, enter your individual email address, a password of your choice (at least five characters), and a display name that will be publicly visible.

Contact Us

Phone
(800) 678-4644 (Sales)
(800) 346-4504 (Support)

Website
www.ortho2.com

Email
admin@ortho2.com
engineering@ortho2.com
ideas@ortho2.com
orders@ortho2.com
ortho2support@ortho2.com
sales@ortho2.com
ugm@ortho2.com

Newsletter Submissions
editor@ortho2.com

Social Media
www.facebook.com/ortho2
www.youtube.com/ortho2systems
www.twitter.com/ortho2systems
www.linkedin.com/company/ortho2
www.instagram.com/ortho2systems
https://plus.google.com/+ortho2
http://blog.ortho2.com
www.ortho2.uservoice.com
Referral Rewards

You can earn a $500 credit for each referral that results in an Ortho2 system purchase within six months. You can apply the credit toward any current or future charge or purchase—it never expires. We frequently hear from doctors that they wish we had contacted them before they purchased their current system. We wish we had too, but we didn’t know they were looking. You can help us help your colleagues by letting us know when they are considering a change in systems. Enter referrals online at www.ortho2.com and clicking on the Referral Rewards icon in the top right corner, or call (800) 678-4644.

Service Excellence

We invite you to recognize Ortho2 employees by sending Extra Mile cards. A card is included in this newsletter, or you may send cards online from the Contact Us page of our website. Our goal is to uphold our tradition of excellence in customer service, and with our Extra Mile program, you can let our employees know when you appreciate their extra effort. We encourage you to send an Extra Mile card whenever an Ortho2 employee goes the extra mile for you. The recognition is valued by the recipient and is acknowledged by our management team. We continue to look for better ways to serve you. Thank you for helping us recognize excellence.

Join Our Email List

Here’s an exciting opportunity to enhance your success with Ortho2 products and services and be among the first to get news. We have an email communication program which includes money saving discounts and incentives, overviews of new features, productivity tips, meeting updates, periodic optional feedback surveys, and more. We think you will like getting these messages.

Furthermore, we believe associate doctors and members of your staff will benefit from the productivity and usage tips, and we would encourage them to sign up as well.

To register email addresses for this program, simply visit the Register for Updates section of our website, www.ortho2.com > Resources > Register for Updates. As mentioned above, multiple individuals from your office can register. Even if we already have your email address, it won’t hurt to register here, and it will guarantee your inclusion in this program.

And of course, if you or any of your staff ever decide that the messages are not of interest, you can simply use the opt-out option provided on each message.
Coordinator System continued from page 6

let him or her know what's going on in the practice. I find that many problems that arise in the practice are simply from not setting aside to clearly communicate with the doctor and team members.

While this was but a brief introduction to the coordinator system that was developed by the Millennium Management Society 35 years ago, beginning the process of developing your management system is a first strong step toward reducing potential management headaches, and may someday even get you to a point where you exclaim, “Management is fun!”

Mobile-First Indexing continued from page 7

domino effect that causes your ranking to fall way behind your competitors.

My Website is Already Responsive – What’s Next?

A website is never fully complete; there is always room for improvement. Test your website on every brand of phone and tablet you can get your hands on. Look for quirks or flaws in the design that might only show on certain devices. Also, test your website in multiple browsers such as Chrome, Firefox, and Internet Explorer.

You may also want to ask your webmaster if your site has schema markup, which is code that goes on a website to help search engines return more informative results. Schema markup is the driving force behind rich snippets appearing in search results.

In today’s consumer marketplace, the website is where you make your first impression with potential patients, and it is also your most powerful selling tool. An outdated website tells prospective patients that your practice and your treatment modalities are outdated, too. Don’t make this mistake! Update your website and keep those new patients coming in.

Management Mistakes continued from page 9

8. Overdue Debonds

You don’t want to continue treating patients past their official end date. But that’s what happens with overdue debonds. These patients got off track during the course of treatment by missing a couple of appointments. I’ve known orthodontists who had trouble fitting in new patients because their schedules were so clogged with overdue debonds.

If patients miss an appointment, get them back in the practice as soon as possible. You don’t want patients going off schedule because that will eventually wreck your schedule.

Getting better as a practice owner means avoiding the big mistakes. Levin Group has worked with thousands of orthodontists over the years, and most of our new clients have made many of these mistakes, sometimes multiple times. By eliminating these missteps, you can improve practice performance immeasurably!
If you are focusing more on management than you are on orthodontics, consider if you are making one of these eight management mistakes in your practice.

page 8

Google is changing the way they rank businesses when searching online. Are you prepared for mobile-first indexing?

page 7

Just like the point guard on a basketball team does more leading than scoring, so should the three main coordinators in your office. Consider introducing a coordinator system.

page 6